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Preface

This publication is for the customer who is installing and/or operating the Virtual 
Operator Panel (VOP), whenever a Service Delivery Platform (SDP) is not present. 

Note – When an SDP site server unit is installed on site, monitoring installed drives via 
an Ethernet private network, the drive Ethernet port is 100% dedicated to the SDP. 
Therefore, the drive Ethernet port is NOT available for customer connection, required 
for VOP interface with the drive. 

Organization
The organization of this guide is: 

 

Chapter 1 “Virtual Operator Panel Overview” provides an overview and prerequisite 
information regarding the virtual operator panel. 

Chapter 2 “Software Installation” provides guidelines for installing Java Runtime 
Environment, and the virtual operator panel application software. 

Chapter 3 “Virtual Operator Panel Operation” provides guidelines for using the virtual 
operator panel to interface with a drive. 

Appendix A “Changing the Computer IP Address” provides guidelines for setting static 
IP address, and resetting for dynamic IP address.

Appendix B “VOP to Drives on Private Networks” provides guidelines for configuring 
drives in the multi-drive environment with the VOP.

Glossary The “Glossary”defines some terms and abbreviations used in this guide. 

Index The “Index” provides an additional means of locating information within this 
document. 



 

16 T10000 Operator’s Guide • September 2007 Revision J   • 96179

Additional Information
This section offers several methods to obtain additional information. 

Sun’s External Web Site 
Sun’s external Web site provides marketing, product, event, corporate, and service 
information. The external Web site is accessible to anyone with a Web browser and an 
Internet connection.

The URL for the  external Web site is: http://www.sun.com

The URL for StorageTek™ brand-specific information is: 
http://www.sun.com/storagetek/

Customer Resource Center
The Sun Microsystem’s StorageTek Customer Resource Center (CRC) is a Web site that 
enables members to resolve technical issues by searching code fixes and technical 
documentation for StorageTek brand products. CRC membership entitles you to other 
proactive services, such as HIPER subscriptions, technical tips, answers to frequently 
asked questions, addenda to product documentation books, and online product support 
contact information. Customers who have a current warranty or a current maintenance 
service agreement may apply for membership by clicking on the Request Password 
button on the CRC home page. 

The URL for the CRC is http://www.support.storagetek.com 

Customer-Initiated Maintenance
Customer-initiated maintenance begins with a telephone call from you to Sun 
Microsystems StorageTek Support. You receive immediate attention from qualified  
personnel, who record problem information and respond with the appropriate level of 
support.

To contact  Microsystems StorageTek Support about a problem, use the telephone and 
call:

 800.525.0369 (inside the United States)

 303.673.4056 (outside the United States)

http://www.sun.com
http://www.sun.com/storagetek/
http://www.support.storagetek.com
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Internal Code License Statement

The following is the Internal Code License Agreement from StorageTek:
NOTICE

INTERNAL CODE LICENSE
PLEASE READ THIS NOTICE CAREFULLY BEFORE INSTALLING AND OPERATING THIS EQUIPMENT. THIS 
NOTICE IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR ENTITY), THE END USER, 
AND STORAGE TECHNOLOGY CORPORATION (“STORAGETEK”), THE MANUFACTURER OF THE 
EQUIPMENT. BY OPENING THE PACKAGE AND ACCEPTING AND USING ANY UNIT OF EQUIPMENT 
DESCRIBED IN THIS DOCUMENT, YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. 
IF YOU DO NOT AGREE WITH THE TERMS OF THIS AGREEMENT, DO NOT OPEN THE PACKAGE AND USE 
THE EQUIPMENT. IF YOU DO NOT HAVE THE AUTHORITY TO BIND YOUR COMPANY, DO NOT OPEN THE 
PACKAGE AND USE THE EQUIPMENT. IF YOU HAVE ANY QUESTIONS, CONTACT THE AUTHORIZED 
STORAGETEK DISTRIBUTOR OR RESELLER FROM WHOM YOU ACQUIRED THIS EQUIPMENT. IF THE 
EQUIPMENT WAS OBTAINED BY YOU DIRECTLY FROM STORAGETEK, CONTACT YOUR STORAGETEK 
REPRESENTATIVE. 

1. Definitions: The following terms are defined as 
follows:
a. “Derivative works” are defined as works based 

upon one or more preexisting works, such as a 
translation or a musical arrangement, or any other 
form in which a work might be recast, transformed, 
or adapted. A work consisting of editorial revision, 
annotations, elaboration, or other modifications 
which, as a whole, represent an original work of 
authorship, is a Derivative work.

b. “Internal Code” is Microcode that (i) is an integral 
part of Equipment, (ii) is required by such 
Equipment to perform its data storage and retrieval 
functions, and (iii) executes below the user interface 
of such Equipment. Internal code does not include 
other Microcode or software, including data files, 
which might reside or execute in or be used by or in 
connection with such Equipment, including, 
without limitation, Maintenance Code.

c. “Maintenance Code” is defined as Microcode and 
other software, including data files, which might 
reside or execute in or be used by or in connection 
with Equipment, and which detects, records, 
displays, and/or analyzes malfunctions in the 
Equipment.

d. “Microcode” is defined as a set of instructions 
(software) that is either imbedded into or is to be 
loaded into the Equipment and executes below the 
external user interface of such Equipment. 
Microcode includes both Internal Code and 
Maintenance Code, and might be in magnetic or 
other storage media, integrated circuitry, or other 
media.

2. The Equipment you have acquired by purchase or 
lease is manufactured by or for StorageTek and 
contains Microcode. By accepting and operating this 
Equipment, you acknowledge that StorageTek or its 

licensor(s) retain(s) ownership of all Microcode, 
as well as all copies thereof, that might execute 
in or be used in the operation or servicing of the 
Equipment and that such Microcode is 
copyrighted by StorageTek or its licensor(s).

3. StorageTek hereby grants you, the end user of the 
Equipment, a personal, nontransferable (except as 
permitted in the transfer terms below), nonexclusive 
license to use each copy of the Internal Code (or any 
replacement provided by StorageTek or your 
authorized StorageTek distributor or reseller) which 
license authorizes you, the end user, to execute the 
Internal Code solely to enable the specific unit of 
Equipment for which the copy of Internal Code is 
provided to perform its data storage and retrieval 
functions in accordance with StorageTek’s (or its 
licensor’s) official published specifications.

4. Your license is limited to the use of the Internal Code 
as set forth. You might not use the Internal Code for 
any other purpose. You might not, for example, do 
any of the following:

(i) access, copy, display, print, adapt, alter, 
modify, patch, prepare Derivative works of, 
transfer, or distribute (electronically or 
otherwise) or otherwise use the Internal Code;
(ii) reverse assemble, decode, translate, 
decompile, or otherwise reverse engineer the 
Internal Code (except as decompilation might be 
expressly permitted under applicable European 
law solely for the purpose of gaining 
information that allows interoperability when 
such information is not otherwise readily 
available); or
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(iii) sublicense, assign, or lease the Internal Code 
or permit another person to use such Internal 
Code, or any copy of it.

5. Nothing in the license set forth above or in this entire 
Notice shall convey, in any manner, to you any license 
to or title to or other right to use any Maintenance 
code, or any copy of such Maintenance Code. 
Maintenance Code and StorageTek’s service tools and 
manuals might be kept at your premises, or they 
might be supplied with a unit of Equipment sent to 
you and/or included on the same media as Internal 
Code, but they are to be used only by StorageTek’s 
customer service personnel or those of an entity 
licensed by StorageTek, all rights in and to such 
Maintenance Code, service tools and manuals being 
reserved by StorageTek or its licensors. You agree that 
you shall not use or attempt to use the Maintenance 
Code or permit any other third party to use and access 
such Maintenance Code.

6. You, the end user, agree to take all appropriate steps 
to ensure that all of your obligations set forth in this 
Notice are extended to any third party having access 
to the Equipment.

7. You might transfer possession of the Internal Code to 
another party only with the transfer of the Equipment 
on which its use is authorized, and your license to use 
the Internal Code is discontinued when you are no 
longer an owner or a rightful possessor of the 
Equipment. You must give such transferee all copies 
of the Internal Code for the transferred Equipment 
that are in your possession, along with a copy of all 
provisions of this Notice.

Any such transfer by you is automatically 
(without further action on the part of either 
party) expressly subject to all the terms and 
conditions of this Notice passing in full to the 
party to whom such Equipment is transferred, 
and such transferee accepts the provisions of this 
license by initial use of the Internal Code. You 
cannot pass to the transferee of the Equipment 
any greater rights than granted under this 
Notice, and shall hold StorageTek harmless from 
any claim to the contrary by your transferee or 
its successors or assigns. In addition, the terms 
and conditions of this Notice apply to any copies 
of Internal Code now in your possession or use 
or which you hereafter acquire from either 
StorageTek or another party.

8. You acknowledge that copies of both Internal Code 
and Maintenance Code might be installed on the 
Equipment before shipment or included with the 
Equipment and other material shipped to you, all for 
the convenience of StorageTek’s service personnel or 
service providers licensed by StorageTek, and that 
during the warranty period, if any, associated with the 
Equipment, and during periods in which the 
Equipment is covered under a maintenance contract 
with StorageTek or service providers licensed by 
StorageTek, both Internal Code and Maintenance Code 
might reside and be executed in or used in connection 
with such Equipment, and you agree that no rights to 
Maintenance Code are conferred upon you by such 
facts. 

StorageTek or the licensed service provider 
might keep Maintenance Code and service tools 
and manuals on your premises but they are to be 
used only by StorageTek’s customer service 
personnel or those of service providers licensed 
by StorageTek. You further agree that upon  
(i) any termination of such warranty period or 
maintenance contract period; or  
(ii) transfer of possession of the Equipment to 
another party, StorageTek and its authorized 
service providers shall have the right with 
respect to the affected Equipment to remove all 
service tools and manuals and to remove or 
disable all Maintenance Code and/or replace 
Microcode which includes both Internal Code 
and Maintenance Code with Microcode that 
consists only of Internal Code.
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CHAPTER 1

Virtual Operator Panel Overview

Introduction
The Virtual Operator Panel (VOP) is a computer-based Graphical User Interface (GUI) 
that provides operational interface to the T10000 Tape Drive.

Because the T10000 Tape Drive does not have a built-in, physical operator panel, the 
primary means of operational interface is via the drive Ethernet port (see FIGURE 1-1). 

Note – The only exception would be when the drive is mounted in a rack mount 
chassis, which has a physical operator panel for each drive. However, you can still use 
the VOP interface with a rack mount configured drive.

FIGURE 1-1 T10000 Tape Drive Rear Panel 

1. Ethernet Port 
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With access to the drive’s Ethernet port and the VOP application installed on a 
computer, you can connect to a drive for operational interface.

Once connected to a drive, the VOP provides an intuitive and user-friendly GUI to 
display drive-related information, and allow operator interface with the drive.

Note – Data-related interface is NOT possible with the VOP, because data 
input/output is strictly a function within the Host software application interface.

VOP Application Window
The VOP application opens within its own window on a computer display screen.  
FIGURE 1-2 depicts the VOP (Windows OS) after connection to a drive.The drive name 
area displays the drive IP. The primary drive message window shows a recently loaded 
encryption key. The VOP text message pane displays the VOP transcript, from the 
connection initiation to the time the screen was captured. The drive status indicators 
show that a cartridge is not loaded; the drive is online; the drive is in need of a cleaning 
cartridge operation; the optional heartbeat is enabled; and that the drive is encryption-
enabled (see TABLE 1-1 on page 23 for complete drive status indicator states).

Note – VOP on Linux or Unix OS is very similar, but with a Linux/Unix look and feel.

FIGURE 1-2 VOP Application Window 

1. Menu bar 
2. Drive IP/name 
3. Primary drive message window 
4. Secondary drive message window 
5. VOP transcript pane 
6. Drive status indicators 
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Menu Bar Description
The menu bar contains several drop-down menus to allow selection of commands 
and/or sub-menus.

The File and Help menus are the only available menus before connecting to a drive.  
The Drive Operations, Retrieve, and Configure menus have expanded sub-menus and 
additional commands available only when VOP is connected to a drive.

Note – See to Chapter 3 for details and guidelines for using all VOP menus.

File Menu 
The File menu (FIGURE 1-3) has three commands.

Clear Transcript 

This command clears the VOP transcript pane of the VOP application window. 

Note – Once connection to a drive is initiated, a transcript of relevant VOP messages 
appears in the VOP text message pane (see FIGURE 1-2 on page 20).

Connect to Drive 

This command initiates a connection to a drive. 

Note – Chapter 3 will provide guidelines for connecting to a drive and operating all 
other VOP functions.

Exit 

This command halts the VOP application and closes the window. 

FIGURE 1-3 VOP File Menu 
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Help Menu 
The Help menu (FIGURE 1-3) only has one command.

About 

The Drive About Dialog box appears when About is selected. It provides basic 
information about the VOP, such as VOP version and build date, Java Runtime 
Environment version, and displays some drive information if the VOP is connected to a 
drive.

Note – Drive name and drive IP address information is displayed only when the VOP 
is connected to a drive. 

FIGURE 1-4 VOP Help Menu 
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Drive Status Indicators 
When the VOP is connected to a drive, the drive status indicators (FIGURE 1-5) change 
color to indicate different drive conditions. Clicking on certain indicators, such as 
Online, toggles the drive to the alternative condition, and the label changes accordingly.

TABLE 1-1 describes the VOP status indicators, including the color meanings.
  

FIGURE 1-5 Drive Status Indicators 

TABLE 1-1 Drive Status Indicators  

Indicator Color Meaning

All Black Indicates no connection to a tape drive

Loaded 
Unload 
 
 
Empty

Blue 
Grey 
 
Magenta 
Grey

Indicates that a cartridge is loaded in the drive 
Indicates that a cartridge is present in the loading slot,  
but NOT loaded in the drive 
Indicates cartridge loading/unloading is in transition 
Indicates that a cartridge is NOT present in the loading slot

Online 
Offline

Blue 
Grey 
Magenta

Indicates that the drive is online (label reads “Online”) 
Indicates that the drive is offline (label reads “Offline”) 
Indicates online/offline is in transition

Clean Orange Indicates that the drive needs to be cleaned 

Dump Orange Indicates that there is an un-retrieved dump present 

Heart 1 Blue/grey Alternates blue/grey (1 cps) while the VOP-to-drive connection is 
active. 

Encryption 2 Red 
Orange

Indicates that the drive is encryption-enabled, and has all keys. 
Indicates a needed encryption key is missing  
(label indicates the enabled status, or identifies a missing key)

1. The heart indicator is present only when the “-b” (heartbeat feature) parameter is set in the VOP batch 
file. The heart beat indication is optional, and some what redundant because all other status indicator turn 
black when the VOP-to-drive connection is lost.

2. The encryption status indicator is present only with an encryption-capable drive that is encryption-
enabled.
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Prerequisites 
Before you can install and operate the VOP application, your system must meet certain 
prerequisites. There are minimum hardware requirements, operating system 
certification, and Java Runtime Environment minimum release level requirement.

Computer Hardware Requirements 
Minimum hardware requirements for the VOP application:

■ 512 MB memory 
■ 1.0 GHz processor 
■ Monitor screen resolution 1280 x 1024
■ Ethernet port available for static IP addressing
■ RJ45-RJ45 Ethernet cross-over cable (direct connection to drive) 
■ RJ45-RJ45 Ethernet cables (indirect connection through an Ethernet switch)

Note – See Appendix B for indirect Ethernet connection guidelines.

Operating System Certification 
The following operating systems are certified for VOP: 

■ Windows 2000 or XP 
■ Linux–Redhat 9.0, ES 
■ Solaris–SunOS 5.8, SunOS 5.9, and SunOS 5.10

Note – Platforms with newer operating systems might work,  
but have not yet been tested and certified by Sun Microsystems.  
Platforms with older operating systems likely do not meet the minimum 
hardware requirements (see“Computer Hardware Requirements”).

Java Runtime Environment Requirement 
The VOP software application is a Java-based program. Therefore, you need a 
compatible version of Java Runtime Environment (JRE) installed on your computer. 

Note – Your computer must have version JRE 1.5, or higher to properly install and run 
VOP.

Before attempting to install and run VOP, verify the presence, and release level of JRE. 
On Windows OS, open the Control Panel, and double-click Add and Remove Programs.  
On Linux/Unix OS, see your system administrator.

JRE should be listed with the version release level clearly stated. 

■ If listed and JRE 1.5, or higher, go to “VOP Application Software” on page 28.

■ If not listed, or less than JRE 1.5, go to “Java Runtime Environment” on page 25. 
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Software Installation

This chapter provides guidelines to install/update Java Runtime Environment (JRE), 
and/or the Virtual Operator Panel (VOP) Customer version application. 

Note – When a Service Delivery Platform (SDP) site server unit is installed on site, 
monitoring installed drives via an Ethernet private network, the drive Ethernet port is 
100% dedicated to the SDP. Therefore, the drive Ethernet port is NOT available for 
customer connection, required for VOP interface with the drive. 

Java Runtime Environment 
To install/update Java Runtime Environment, go to http:\\www.sun.com.

Note – The Sun.com web pages are dynamic, and subject to frequent changes. 
Therefore, the actual pages you see might differ from the examples in this section 
(FIGURE 2-1 through FIGURE 2-4 on page 27). However, you should still be able to make 
appropriate selections. Read the prompt text carefully before making selections.

1. Choose Java 2 Standard Edition from the Downloads menu.

A page containing all available Java SE downloads opens (FIGURE 2-2 on page 26).

FIGURE 2-1 Sun.com Home Page

www.sun.com


 

Java Runtime Environment

26 T10000 Operator’s Guide • September 2007 Revision J   • 96179

2. Make sure the Latest Release section is active. If not, click it.

Note – The list of the latest release of Java SE downloads is rather long; therefore, all 
but the Java Runtime Environment has been removed from the illustration. JRE 6u1 was 
the latest release, as of this documentation revision.

3. Click Download to start the JRE download.

A list of available platform versions and the License Agreement appears (FIGURE 2-3).

Note – You must Accept the License Agreement to download any selection.

FIGURE 2-2 Java SE Downloads

FIGURE 2-3 Java License Agreement
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After you accept the License Agreement, select the platform version to match the 
operating system of your PC, and select offline/online installation (FIGURE 2-4). Offline 
installation saves a large executable file that you run after exiting Sun.com. Online 
installation saves a small executable file that you must run while still online.

Note – There are several additional platform selections available than are shown in 
FIGURE 2-4. Review the complete list before making your selection.

4. Select the appropriate check box, then click the adjacent link.

If you selected offline installation, you are prompted to specify the location for the large 
executable installation file. You can then exit Sun.com.

If you selected online installation, a small installer executable file is saved to your 
desktop. You should remain online to Sun.com until the installation is finished.

5. Double-click the executable file to start the installation process.

The installation process takes several minutes, and requires you to respond to a few 
prompts. Once the installation is complete, you are set to install/run the VOP. 

If you used the online installation version, you may now exit Sun.com.  
You can also delete either executable file used for the JRE installation/update.

Note – The JRE installation/update does not remove old JRE versions. However, their 
continued presence is ignored. Use discretion about removing older JRE versions.

FIGURE 2-4 Platform Version Selection
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VOP Application Software 
The VOP application software installation/update process consists of four parts:

■ Download the latest VOP version (zip file)
■ Extract/unpack the zipped (compressed) contents
■ Install/set up the application
■ Post-installation options

▼ Download VOP Zip 
Begin the VOP installation process by downloading the latest VOP version release level 
zip file from the Sun/StorageTek Customer Resource Center (CRC), or another 
designated download resource.

1. Create a local sub-folder for the VOP download.

We recommend creating the folder as a direct sub to the root (home folder in 
Linux/UNIX) and naming it “VOP_download”, or another name of your choice.

Note – This folder is temporary, and will be deleted after the installation.

2. Login to the CRC.

Go to: http://www.support.storagetek.com/NR/System/Access/ManualLogin.asp. 

Note – You must have a valid CRC Login ID and password. 

3. Navigate to Code Downloads, T10000 Tape Drive.

A list of several versions of T10000 tape drive firmware and VOP appears.

4. Select the latest VOP customer version.

A download instruction box, similar to FIGURE 2-5 appears.

5. Click the file name link.

You are prompted to specify a location to save the zip file.

6. Save the VOP zip file to the folder created in Step 1.

Once the VOP zip file is saved to your local disk, you can exit the CRC.

7. Log out of the download resource.

FIGURE 2-5 VOP Zip Download 

http://www.support.storagetek.com/NR/System/Access/ManualLogin.asp
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VOP Installation, Windows OS Computers 
This section contains guidelines to extract and install the VOP software on computers 
with Microsoft Windows operating system.

Note – See “VOP Installation, Linux/UNIX OS Computers” on page 45 for guidelines 
to extract and install the VOP software on computers with Linux/UNIX operating 
systems.

VOP software installation consists of three parts: extract/unzip VOP files, install VOP, 
and post-installation options.

▼ Extract VOP Files, Windows OS
There are several methods of extracting the VOP folders/files from the zip file, 
depending on the specific operating system of your computer and the compatible 
zip/unzip utility program.

The following guideline is modeled on the Windows XP operating system, and the 
WinZip utility that is typically part of the Windows suite. 

Note – If you do not have WinZip, go to: 
http://www.winzip.com/ovwc17/winzip.htm. 

1. Open the sub-folder that you created in Step 1 of “Download VOP Zip” on page 28.

The VOP zip file that you down-loaded from the CRC should be present.

2. Click the right mouse button on the zip file. 

A pop-up menu, similar to FIGURE 2-6, appears. 

FIGURE 2-6 WinZip Popup Menu

http://www.winzip.com/ovwc17/winzip.htm
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Note – There are multiple means to extract the compressed VOP files. You are free to 
choose any that you are familiar with using. However, the following step is the 
simplest, and most direct choice to extract the VOP files within the download folder.

3. Choose WinZip > Extract to here (see FIGURE 2-7).

The WinZip utility extracts the VOP files into the current folder (see FIGURE 2-8).

Note – The zip file contents will vary, relative to the specific VOP version.

With the VOP files extracted, you are ready to instal/set up the VOP program.  
Go to “set Up the VOP Program, Windows OS” on page 31.

FIGURE 2-7 WinZip Extract to Here

FIGURE 2-8 Extracted VOP Files, Window Explorer
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▼ set Up the VOP Program, Windows OS
On computers with Windows operating system, you have a choice of automatic or 
manual installation setup. This section provides guidelines for both setup procedures 

■ “Automatic Setup”

■ “Manual Setup” on page 35

Automatic Setup

The automatic setup process installs VOP program files within the Windows Program 
Files structure, and creates a Start Menu, Programs path for launching the program.

1. Double-click the setup.exe file.

The setup.exe file is located in the list of extracted VOP files (FIGURE 2-9).

The automatic VOP installation process begins.

Note – During the installation process there are several points where you are asked to 
provide response, see FIGURE 2-10 on page 32. Unless you have compelling reason to 
the contrary, accept all defaults presented.

FIGURE 2-9 Automatic VOP Installation



 

VOP Application Software

32 T10000 Operator’s Guide • September 2007 Revision J   • 96179

Note – Once the installation process is complete, you should verify the Start Menu 
path, and test launch the newly installed VOP version.

FIGURE 2-10 Automatic Installation Progress Points



 

VOP Application Software

96179 • Revision J  Chapter 2 Software Installation 33

2. Click Start, and select the Programs > VOP program folder.

Note – The newly installed VOP version (VOP_<Rel level>_Customer)  
should be listed in the Programs group listing (see FIGURE 2-11).

Note – If this installation was to update a previously auto-installed VOP version,  
the earlier version program folder is also listed.

3. Select the newest VOP version program folder, and click the executable file name.

The VOP application window (FIGURE 2-12) opens. 

Note – There is a noticeable delay opening the VOP application window for the first 
time of every PC power-on session. Subsequent VOP launches, in the same PC power-
on session, are quicker. During the delay, the only visible indication is with the hard 
drive activity indicator.

Note – VOP 1.0.9, and earlier prematurely indicates Connection In Progress in the 
drive message windows. At this point, the application is open, but a drive connection 
has not yet been initiated.

FIGURE 2-11 Start Menu VOP Path

FIGURE 2-12 VOP Application Window
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4. Click Help, then choose About,.

The Drive About Dialog box (FIGURE 2-13) opens.

5. Verify the VOP Version, and the Java Version release levels.

I either the VOP or Java release levels are not correct, you must redo the appropriate 
installation process.

6. Close the Drive About Dialog box.

7. Click File, then choose Exit, or click the “X”, located in the application window 
upper right corner. (see FIGURE 2-14).

The VOP application window closes.

8. .Go to “VOP Post-Installation Options, Windows” on page 38.

FIGURE 2-13 VOP and Java Installation Verification, Solaris

FIGURE 2-14 Exit VOP, Windows
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Manual Setup

The manual setup process installs VOP program files outside the Windows Program 
Files structure

Note – If this installation is to update an existing manually-installed earlier VOP 
version, the existing VOP folder must be renamed. If there is not an existing VOP 
folder, skip to step 2.

1. Rename an existing VOP folder as VOP_old.

See FIGURE 2-15.

2. Move or Copy the new VOP folder from VOP_download, to the root folder.

FIGURE 2-16 shows the location and contents of the new VOP folder.

FIGURE 2-15 Rename VOP Folder

FIGURE 2-16 VOP Folder Location and Contents, Windows Explorer
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3. Delete the multiVOP and sunVOP (no file extensions) files.

These files (FIGURE 2-17) are non-Windows files, and are not needed.

Note – You are asked to confirm the deletion.

The new VOP program is now ready to launch, and you should perform a test launch 
to verify the setup. The sunVOP.bat batch file (FIGURE 2-18) is the executable.

4. Double-click the sunVOP.bat batch file.

The sunVOP batch file window appears; then, the VOP window opens  
(see FIGURE 2-19 on page 37).

FIGURE 2-17 VOP non-Windows Files

FIGURE 2-18 Test Launch VOP, Windows Explorer



 

VOP Application Software

96179 • Revision J  Chapter 2 Software Installation 37

Note – There is a noticeable delay between the bath file window and the opening the 
VOP application for the first time of every PC power-on session while the anti-virus 
scan is in progress. Subsequent VOP launches, in the same PC power-on session, are 
quicker. During the delay, the only visible indication of the VOP program launching is 
with the hard drive activity indicator.

Note – VOP version 1.0.9, and earlier will prematurely indicate Connection In Progress 
in the two drive message window. At this point, the application is open, but a drive 
connection has not been initiated.

5. Click Help, then choose About,.

The Drive About Dialog box (FIGURE 2-13 on page 34) opens.

6. Verify the VOP Version, and the Java Version release levels.

If either the VOP or Java release levels are not correct, you must redo the appropriate 
installation process.

7. Close the About dialog box.

8. Click File, then choose Exit, or click the “X” in the application window upper right 
corner.

See FIGURE 2-14 on page 34.

The VOP application window closes.

9. Go to “VOP Post-Installation Options, Windows” on page 38). 

FIGURE 2-19 VOP Batch File and Application Windows
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▼ VOP Post-Installation Options, Windows
Once you have confirmed the VOP program opens, and is the correct release level, you 
can optionally create shortcuts, modify the opening batch file, and/or delete down-
level versions and/or VOP folders/files that are no longer needed. The VOP download 
folder, created to temporarily hold VOP update downloads should be deleted or 
emptied.

Optional Shortcuts, Windows

If you used automatic installation, you already have a Start Menu type of shortcut,  
and might well choose not to create additional shortcuts. However, if you used manual 
installation, you should, at least, create a desktop shortcut.

Note – If this is an update to a previous manually installed VOP, and a shortcut was 
previously created, it should still work. Check the existing shortcut properties, and edit 
them as needed to target new sunVOP file.

Use the following steps to quickly create a VOP shortcut on the desktop:

1. Click (single-click) the sunVOP.bat file.

The sunVOP batch file name is highlighted (see FIGURE 2-18 on page 36).

2. Click the right mouse button and choose Create Shortcut (FIGURE 2-20).

FIGURE 2-20 Create Shortcut
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The new shortcut (Shortcut to sunVOP.bat) appears on the sub-folder file list.

3. Rename the shortcut.

Keep the name short, such as VOP.

4. Drag and drop the renamed shortcut to the desktop.

The desktop VOP shortcut icon (FIGURE 2-22 should now be functional.

5. Double-click the new desktop VOP shortcut icon to test launch VOP.

See FIGURE 2-19 on page 37 to confirm VOP launch.

Note – You do not need to reconfirm VOP and Java version release levels.

6. Click File, then choose Exit, or click the “X”, in the application window upper right 
corner.

The VOP application window closes.

Note – Use normal Windows functions to create and locate additional shortcuts.

FIGURE 2-21 VOP Batch File

FIGURE 2-22 Desktop VOP Shortcut Icon
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Optional Heartbeat Indication, Windows

In VOP release 1.0.9, and lower, you can optionally enable a heartbeat indicator that 
appears on the VOP application window indicator stack, and blinks while the VOP has 
a running connection with the drive. 

Note – The heartbeat indicator is basically redundant because the VOP will detect an 
inadvertent lost connection with the drive, and display a “heartbeat failure” message in 
the VOP text message window. 

If you want the visual heartbeat indicator on the VOP application window, use the 
following guideline to edit the sunVOP.bat file:

1. Launch a simple text editor.

Notepad or Wordpad is OK.

Note – Avoid using a full word processing application.

2. Locate, and open sunVOP.bat. 

Note – The location of the batch file depends on the type of VOP installation used: 
Auto -     C:\Program Files\VOP_Rel_<release level>_Customer\sunVOP.bat 
Manual - C:\VOP<release level>\sunVOP.bat

The following, or similar lines of text should appear:

#   %1 is optional drive ip address to connect to java -classpath 
"lib;lib/VOP.jar;lib/borland.jar" -Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain %1

cd bin

3. Insert -b, followed by a space, just before the %1 in the last text line. 

For example: “VOPMain %1” edited to “VOPMain -b %1”.

Note – The -b parameter enables the heartbeat indicator. 
To disable an existing heartbeat indicator, delete the -b parameter.

4. Save and close the batch file.

When the VOP application window is open, the heartbeat indicator is present, as seen 
in FIGURE 2-23. While the VOP is connected to a drive, the indicator blinks.

FIGURE 2-23 Heartbeat Indicator
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Delete/Remove Folders/Files, Windows

Note – Although there is not any requirement to remove/delete no-longer-needed 
VOP folders, it is considered best practice to do so, once the newest version is fully 
functional. Even if the newest version becomes dysfunctional later, you can 
redownload, and reinstall the current version.

The following procedure removes/deletes no-longer-needed VOP program files: 

Note – Perform steps 1 & 3 following an automatic installation. 
Perform steps 2 & 3 following a manual installation.

1. Remove an auto-installed down-level VOP program folders/files:

a. Open the Control Panel, Add or Remove Programs utility.

All auto-installed VOP versions are listed (FIGURE 2-24).

b. Select the down-level VOP program.

Once you make the selection (VOP_Rel_1_0_8_Customer in FIGURE 2-24), the Add or 
Remove Program window changes, as shown in FIGURE 2-25 on page 42.

FIGURE 2-24 Add or Remove Programs, Windows
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c. Click Change/Remove to start the remove process.

You are asked to confirm the removal (FIGURE 2-26).

d. Click Yes to confirm, or No to cancel, and reselect.

Once the old VOP is removed, you see a confirmation notice (FIGURE 2-27).

e. Click OK, then close the Add or Remove Program window, and the Control Panel.

Note – The last post-installation step is to delete the no longer needed VOP download 
folder used to extract/unpacked folder.

f. Skip to step 3.

FIGURE 2-25 Remove Program Selection, Windows

FIGURE 2-26 Remove Program Confirmation, Windows

FIGURE 2-27 Remove Program Completion, Windows
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2. Delete the down-level VOP_old folders:

a. Open the root folder.

All VOP folders are listed (see FIGURE 2-28).

b. Right-click the down-level VOP_old folder, and choose Delete.

You are asked to confirm the folder deletion (FIGURE 2-29).

c. Click Yes to confirm, or No to cancel, and reselect.

Once the VOP_old folder is deleted, it no longer appears in the folder tree.

Note – The last post-installation step is to delete the no-longer-needed VOP_download 
folder used to extract/unzip the updated VOP folders/files.

d. Continue with step 3.

FIGURE 2-28 Delete VOP_old Folder, Windows

FIGURE 2-29 Delete VOP_old Folder Confirmation, Windows
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3. Delete the VOP_download folder:

a. Open the root folder.

The VOP_download folder you created to hold, and extract/unzip the VOP program 
folders and files is listed (see FIGURE 2-30).

b. Right-click the VOP_download folder, and choose Delete.

You are asked to confirm the deletion (FIGURE 2-31).

c. Click Yes to confirm, or No to cancel, and reselect.

Once the VOP_download folder is deleted, it no longer appears in the folder tree.

FIGURE 2-30 Delete VOP_download Folder, Windows

FIGURE 2-31 Delete VOP_download Folder Confirmation, Windows
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VOP Installation, Linux/UNIX OS Computers 
This section contains guidelines to manually extract and install the VOP software on 
computers with Linux or UNIX operating systems.

The manual installation consists of three parts: extract/unzip VOP files, install VOP, 
and post-installation options.

Note – There are multi ways to accomplish the same task. The following procedures 
are modeled, using Solaris 10. You can use alternate means that you prefer, as long as 
the end results in a launch able VOP installation.

▼ Extract VOP Folders/Files, Linux/UNIX OS
Use the following procedure to extract the zipped VOP files:

1. Launch File Browser.

2. Navigate to the sub-folder that you created in Step 1 of “Download VOP Zip” on 
page 28.

The VOP zip file that you down-loaded should be present.

3. Click and hold the right mouse button over the VOP zip file.

A list of commands appears.

4. Select Extract Here. 

The utility extracts the zipped contents behind the scene.

5. Click Reload in the menu bar.

The screen refreshes, and displays the extracted files (FIGURE 2-32).

With the VOP files extracted, you are ready to install/set up the VOP program.  
Go to “set Up the VOP, Linux/UNIX OS” on page 46.

FIGURE 2-32 Extracted VOP Files, Solaris File Browser
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▼ set Up the VOP, Linux/UNIX OS
With the VOP files extracted, you are ready to setup the VOP program.

1. Make sure the Java JRE, and the VOP/bin folders locations are in the search path 
on the computer. 

If required, use Linux/UNIX utilities specify their locations. This requires that you 
change the $PATH variable in the .cshrc file to include the java/bin directory. In the 
CLASSPATH file, add the path to the java directory.

Note – If this installation is to update an existing manually-installed earlier VOP 
version, the existing VOP folder must be renamed. If there is not an existing VOP 
folder, skip to step 3.

2. Rename an existing VOP folder as VOP_old.

3. Move or Copy the new VOP folder from VOP_download, to the home folder.

Place Solaris screen capture here, like Windows screen capture in FIGURE 2-8 on page 
30.

Verify the new location and contents of the new VOP sub-folder.

Note – You should see three sub-folders: bin, icons, and lib; and three files. the 
sunVOP file (no extension) is the Linux/UNIX executable file.

FIGURE 2-33 Extracted VOP Files, Solaris File Browser
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4. Delete the multiVOP and sunVOP.bat (Windows only) files.

These files (FIGURE 2-34) are not needed with the Linux/UNIX setup.

Note – You are asked to confirm the deletion.

The new VOP program is now ready to launch, and you should perform a test launch 
to verify the setup. The sunVOP file (FIGURE 2-35) is the executable.

5. Double-click the sunVOP file.

The Run or Display? dialog box (FIGURE 2-36 on page 48) appears.

FIGURE 2-34 Unneeded VOP Files, Solaris File Browser

FIGURE 2-35 Test Launch VOP, Solaris File Browser
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6. Click Run

The VOP application launches, and the VOP application window opens  
(see FIGURE 2-37).

Note – VOP version 1.0.9, and earlier prematurely indicates Connection In Progress in 
the drive message windows. At this point, only the application window is open. A 
drive connection has not been initiated.

FIGURE 2-36 Solaris Run or Display? Dialog Box

FIGURE 2-37 VOP Application Window, Solaris



 

VOP Application Software

96179 • Revision J  Chapter 2 Software Installation 49

7. Click Help, then choose About,.

The Drive About Dialog box (FIGURE 2-38) opens.

8. Verify the VOP Version, and the Java Version release levels.

I either the VOP or Java release levels are not correct, you must redo the appropriate 
installation process.

9. Close the Drive About Dialog box.

10. Click File, then choose Exit, or click the “X”, in the application window upper right 
corner. (see FIGURE 2-39).

The VOP application window closes.

11. .Go to “VOP Post-Installation Options, Windows” on page 38.

FIGURE 2-38 VOP and Java Installation Verification, Solaris

FIGURE 2-39 Exit VOP, Solaris
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▼ VOP Post-Installation, Linux/UNIX OS
Once you are satisfied that the newly installed VOP program is functioning OK, you 
can optionally create shortcuts to the sunVOP file, delete down level VOP folders/files, 
and modify the sunVOP batch file.

Optional Shortcut Links

Note – If this is an update to a previous manually installed VOP, and a shortcut was 
previously created, it should still work. Check the existing shortcut properties, and edit 
them as needed to target the new sunVOP file.

Use the following steps to quickly create a VOP shortcut link on the Solaris desktop:

1. Click (single-click) the sunVOP file.

The sunVOP file name is highlighted (see FIGURE 2-35 on page 47).

2. Click the right mouse button and choose Make Link (FIGURE 2-40).

The new shortcut (link to sunVOP) appears on the sub-folder file list.

3. Rename the shortcut link.

Keep the name short, such as VOP.

4. Drag and drop the renamed shortcut link to the desktop.

The desktop VOP shortcut link icon (FIGURE 2-41 should now be functional.

FIGURE 2-40 Link to sunVOP

FIGURE 2-41 Solaris Desktop VOP Link Icon
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5. Double-click the new desktop VOP shortcut icon to test launch VOP.

The Run or Display? dialog box (FIGURE 2-42) appears.

6. Click Run

The VOP application launches, and the VOP application window opens  
See FIGURE 2-43 to confirm VOP launch.

Note – VOP version 1.0.9, and earlier prematurely indicates Connection In Progress in 
the drive message windows. At this point, only the application window is open. A 
drive connection has not been initiated. 
 
You do not need to reconfirm VOP and Java release levels.

7. Click File, then choose Exit, or click the “X”, in the application window upper right 
corner.

The VOP application window closes.

Note – Use normal Solaris functions to create and locate additional shortcuts.

FIGURE 2-42 Solaris Run or Display? Dialog Box

FIGURE 2-43 VOP Application Window, Solaris
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Optional Heartbeat Indication, Linux/UNIX

In VOP release 1.0.9, and lower, you can optionally enable a heartbeat indicator which 
appears on the VOP application window indicator stack, and blinks while the VOP has 
a running connection with the drive. 

Note – The heartbeat indicator is basically redundant because the VOP will detect an 
inadvertent lost connection with the drive, and display a “heartbeat failure” message in 
the VOP text message window. 

If you want the visual heartbeat indicator on the VOP application window, use the 
following guideline to edit the sunVOP file:

1. Launch the Vi text editor.

a. Locate, and open sunVOP. 

Note – The sunVOP file should be located in the version-specific folder created during 
the VOP installation: C:\VOP<release level>\sunVOP

The following, or similar lines of text should appear:

#!/bin/ksh

#cd $HOME/VOP<release level>

#   $1 is optional drive ip address to connect to

VOPdir=`echo $0 |sed 's!/VOP/.*!/VOP!'` 

vopdir2=`echo $VOPdir |grep "\.\/" |wc -c`

if [ $vopdir2 -ne "0" ]

then VOPdir="./" fi

chkVOPdir=`echo $VOPdir |wc -c`

if [ $chkVOPdir -lt "3" ]

then VOPdir=`which $0| sed 's!$0!!'` fi

cd $VOPdir

java -classpath "lib:lib/VOP.jar:lib/borland.jar" -Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain $1 &

b. Insert -b, followed by a space, just before the $1 in the last text line. 

For example: “VOPMain $1 &” edited to “VOPMain -b $1 &”.

Note – The -b parameter enables the heartbeat indicator. 
To disable an existing heartbeat indicator, delete the -b parameter.

c. Save and close the sunVOP file.

d. Enter the command: rehash.
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Delete/Remove Folders/Files, Linux/UNIX

Note – Although there is not any requirement to remove/delete no-longer-needed 
VOP folders, it is considered best practice to do so, once the newest version is fully 
functional. Even if the newest version becomes dysfunctional later, you can 
redownload, and reinstall the current version.

Use normal Linux/UNIX commands to delete no-longer-needed VOP program files:

1. Delete the down-level VOP_old directory/folder.

This folder was replaced by the update VOP.

2. Delete the VOP_download directory/folder

This folder was temporary to hold and extract the updated VOP folders/files, and is no 
longer need.
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3

Virtual Operator Panel Operation

This chapter provides guidelines for Virtual Operator Panel (VOP) operation with a 
single drive interface. See Appendix B for additional guidelines when operating VOP 
within a multiple-drive private network. The VOP does not provide any 
interconnection with the host data input/output interface. 

The VOP has three basic operational functions:
■ Drive status monitoring
■ Drive configuration settings
■ Drive operation utilities

Note – When a Service Delivery Platform (SDP) site server unit is installed on site, 
monitoring installed drives via an Ethernet private network, the drive Ethernet port is 
100% dedicated to the SDP. Therefore, the drive Ethernet port is NOT available for 
customer connection, required for VOP interface with the drive. 

Ethernet Connection to Drive
To interface with a drive using VOP, you must have an Ethernet connection from your 
computer to the Ethernet port on the drive rear panel (see FIGURE 1-1 on page 19). 

■ Direct to the drive: You must use a single crossover Cat-5 Ethernet cable.

■ Indirect (through an Ethernet switch): You must use a straight Cat-5 Ethernet cable 
to connect your computer to the switch. The switch-to-drive cable should already be 
connected.

Note – See Appendix B, “VOP to Drives on Private Networks” for additional 
guidelines when connecting through an Ethernet switch.

Also, your computer must be configured with a static IP address, compatible with the 
target drive. 

Note – See Appendix A, “Changing the Computer IP Address” for guidelines.

Once you have Ethernet connection to a drive, and a compatible static IP on your 
computer, you are ready to operate VOP.



 

Starting VOP

56 T10000 Operator’s Guide • September 2007   Revision J • 96179

Starting VOP
This section contains guidelines for starting the VOP application. Since the operating 
systems provide multiple means to start/launch applications, you can choose any one 
of the several listed here; and, a different one at any future VOP session:

■ “Start Menu, Programs List (Windows)”
■ “Start Menu, Run Dialog Box (Windows)” on page 58
■ “Optional Desktop Shortcut (Windows)” on page 59
■ “Windows Explorer (Windows)” on page 59. 
■ “Launch Menu, Terminal (Linux/UNIX)” on page 60
■ “Optional Desktop Link (Linux/UNIX)” on page 61
■ “File Browser (Linux/UNIX)” on page 61

▼ Start Menu, Programs List (Windows) 
When the VOP was installed, the windows automatic setup utility created a pointer in 
the start menu program list that points to the VOP executable file.

1. Click Start and select the Programs > VOP program folder.

Note – All installed VOP versions (vop_<Rel level>_service) are listed in the Programs 
group (see FIGURE 3-1).

2. Click the pointer name.

Note – If there are multiple VOP programs listed, make sure you have selected the 
intended folder before clicking the pointer.  
Down-level VOP programs that have not been removed, are also listed.

FIGURE 3-1 Start Menu, Programs List VOP Path
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The VOP window opens (FIGURE 3-2). You can resize and move the window around the 
desktop. See FIGURE 1-2 on page 20 for detailed descriptions of the window sections.

Note – There is a noticeable delay opening the VOP application window for the first 
time of every PC power-on session while your anti-virus scans.  
During the delay, the only visible indication is with the hard drive activity indicator. 
Subsequent VOP launches, in the same powered session, are quicker. 

Note – VOP 1.0.9, and earlier prematurely indicates Connection In Progress in the 
drive message windows. At this point, the application is open, but a drive connection 
has not been initiated.

See “Using VOP Menus and Controls” on page 62 for VOP operational guidelines, 
including Connect to Drive.

FIGURE 3-2 VOP, Not Connected
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▼ Start Menu, Run Dialog Box (Windows) 
Use the following guidelines to launch VOP from the Run dialog box:

1. Click Start.

The Start menu (FIGURE 3-3) opens.

2. Select Run.

The Run dialog box (FIGURE 3-4) opens.

3. Do one of the following:
■ Enter the path to the desired VOP executable file.
■ Click the down arrow to select a previous entry.
■ Click the Browse command button to locate the desired VOP executable file.

Note – The path must point through the specific folder.

4. Click OK.

The VOP opens (FIGURE 3-2 on page 57). 

See “Using VOP Menus and Controls” on page 62 for VOP operational guidelines, 
including Connect to Drive.

FIGURE 3-3 Start Menu,

FIGURE 3-4 Run Dialog Box
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▼ Optional Desktop Shortcut (Windows) 
If you created an optional desktop shortcut (FIGURE 3-5):

1. Double-click the shortcut icon.

The VOP opens (FIGURE 3-2 on page 57). 

See “Using VOP Menus and Controls” on page 62 for VOP operational guidelines, 
including Connect to Drive.

▼ Windows Explorer (Windows)
You can optionally start VOP from Windows Explorer (FIGURE 3-6):

1. Navigate to the VOP folder, then double-click the VOP executable file.

The VOP opens (FIGURE 3-2 on page 57). 

See “Using VOP Menus and Controls” on page 62 for VOP operational guidelines, 
including Connect to Drive.

FIGURE 3-5 Desktop VOP Shortcut Icon

FIGURE 3-6 VOP Executable File
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▼ Launch Menu, Terminal (Linux/UNIX)
1. Click Launch, then select Applications > Utilities > Terminal

A Terminal window opens.

Note – Make sure you are in the home directory/folder, or specify the complete path 
with the command.

2. Enter the command sunVOP. 

The VOP application launches, not connected (FIGURE 3-7).  
See FIGURE 1-2 on page 20 for detailed descriptions of the application window 
sections.

Note – If you include the drive’s IP or alias, VOP will open and auto-connect to the 
designated drive (see FIGURE 3-9 on page 62).

Note – VOP version 1.0.9, and earlier prematurely indicates Connection In Progress in 
the drive message windows. At this point, only the application window is open. A 
drive connection has not been initiated.

See “Using VOP Menus and Controls” on page 62 for VOP operational guidelines, 
including Connect to Drive.

FIGURE 3-7 VOP, Not Connected, Solaris
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▼ Optional Desktop Link (Linux/UNIX)

Note – If you’re using the File Browser, you must first navigate to the directory/folder 
which contains the executable file sunVOP. This directory/folder is typically sub to the 
home directory/folder, and named VOP. 

1. Double-click the sunVOP file name/icon, or the desktop link icon.

The Run or Display? dialog box FIGURE 3-8() appears.

2. Click Run

The VOP application launches, not connected (see FIGURE 3-7 on page 60).

See “Using VOP Menus and Controls” on page 62 for VOP operational guidelines, 
including Connect to Drive.

▼ File Browser (Linux/UNIX)

Note – If you’re using the File Browser, you must first navigate to the directory/folder 
which contains the executable file sunVOP. This directory/folder is typically sub to the 
home directory/folder, and named VOP. 

1. Double-click the sunVOP file name/icon.

The Run or Display? dialog box (FIGURE 3-8) appears.

2. Click Run.

The VOP application launches, not connected (see FIGURE 3-7 on page 60).

See “Using VOP Menus and Controls” on page 62 for VOP operational guidelines, 
including Connect to Drive.

FIGURE 3-8 Run or Display? Dialog Box
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Using VOP Menus and Controls
This section provides guidelines for using the VOP menus, sub-menus, and other 
controls, such as dialog boxes and status indicators.

Note – The VOP application window illustrations in this section were captured on a 
Windows XP platform. The Linux/UNIX platform VOP application window has a 
slightly different look (see FIGURE 3-7 on page 60); however, the following guidelines 
apply equally. 

The VOP application window provides several drop-down menus. When the drive is 
online, unavailable menus are dimmed, such as the Configure menu label in FIGURE 3-9, 
which is only available when the drive is offline. Some menu commands have sub-
menus and/or dialog boxes to further refine your operational selections. 

Some status indicators are also an active link that allow you to toggle the state of the 
monitored drive item. 

Note – The mouse cursor does not change when you mouse-over such an indicator.

During the course of selected operations, the VOP text message pane displays a 
transcript of the VOP actions, and will prompt you for additional input.

Note – The following sections provide more detailed guidelines.

FIGURE 3-9 VOP Window Menus and Indicator/Controls
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▼ Menu Bar Selections
In general, the following two steps are basic for all menus:

1. Click on an available menu label.

A drop-down list of available commands appears.

2. Select a command or sub-menu.

The drive message text windows, drive status indicators, and the VOP text message 
pane provide informational feedback.

File Menu 
Three commands are available in the File menu.

■ Clear Transcript
■ Connect to Drive,  on page 64
■ Exit,  on page 65

Note – File commands are available whether connected to a drive or not, and if 
connected, online and offline.

▼ Clear Transcript 
Use the following guidelines to clear the VOP transcript:

1. Click File to open the menu.

2. Choose Clear Transcript (FIGURE 3-10) to clear text in the VOP transcript pane. 

T7he entire VOP transcript pane clears and the file menu closes.

FIGURE 3-10 Clear Transcript
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▼ Connect to Drive 
Use thefollowing guidelines to connect VOP to a designated drive:

Note – Once a drive is connected, use this command to disconnect, and connect to a 
different drive. 

1. Click File to open the menu.

2. Choose Connect to Drive (FIGURE 3-11). 

The Connect to Drive dialog box (FIGURE 3-12 on page 64) opens. 

3. Enter the drive’s IP address or alias, then click OK.

Factory preset (10.0.0.1), a preassigned static IP, or a preassigned alias.

Once the VOP establishes connection with the designated drive, the VOP window 
changes to the connected stage (see FIGURE 3-13).

FIGURE 3-11 Connect to Drive 

FIGURE 3-12 Connect to Drive Dialog Box, Windows



 

Using VOP Menus and Controls

96179 • Revision J  Chapter 3 Virtual Operator Panel Operation 65

Note – When operating VOP with a single drive, disconnect the crossover cable, and 
reconnect it to a different drive. If the newly connected drive has the same IP (factory 
preset 10.0.0.1), the VOP will auto-reconnect to the new drive. 
Otherwise, perform Step 3 on page 64 to designate a different drive IP. 

When operating in a private network, leave the PC Ethernet cable connected to the 
Ethernet switch, and perform Step 3 on page 64 to designate a different drive IP. 

▼ Exit 
Use the following guidelines to exit the VOP session:

1. Click File to open the menu.

2. Choose Exit (FIGURE 3-14). 

The VOP application window closes.

Note – If the VOP was connected to a drive, the Ethernet connection terminates.

FIGURE 3-13 VOP, Connected, Windows

FIGURE 3-14 Exit
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Drive Operations Menu 
FIGURE 3-15 shows the online commands of the Drive Operations menu.

Note – Notice that the Format Tape label is dimmed, which indicates that it is not 
available online. Format Tape commands are only available when the drive is offline. 

Load Tape 
This command causes a cartridge that is present in the loading slot to load. 

Note – The only time a cartridge would be present in the loading slot, but not loaded 
occurs when it had been previously loaded, then unloaded, but not physically removed.

Unload Tape 
This command causes a loaded cartridge to rewind and unload.

Note – An unloaded cartridge must be physically removed from the drive by library 
robotics or manually from the rack mount configuration. Otherwise, it remains in the 
loading slot, but NOT loaded into the drive.

Set Offline/Online 
■ When the tape drive is online, this command reads Set Offline. 

Click Set Offline to set the drive offline.

■ When the tape drive is offline, this command reads Set Online. 
Click Set Online to set the drive online. 

FIGURE 3-15 Drive Operations Menu 
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IPL Drive 
This command causes the tape drive to perform an initial program load (IPL).

Note – VOP looses communications with the drive during the IPL. Once the drive IPL 
is successfully completed, VOP automatically reconnects with the drive. 

Force Dump 
This function forces a diagnostic dump of current contents of various drive registers. 
This dump is stored in the tape drive’s internal memory and the dump status indicator 
changes to orange. 

Note – The forced dump operation also causes a drive IPL; and, once the drive 
successfully completes the IPL, fffc appears in the drive message window.

Format Tape 
This command is only available when the drive is offline. 
(see “Format Tape Submenu” on page 68 for details.)

Note – The following drive operation commands only appear on the menu for 
encryption-capable drives that are also encryption-enabled. Refer to the encryption 
documentation for more information.

Reset Drive 
This command erases all current media keys from the drive volatile memory. 
The drive is inoperable until media keys are loaded into the drive memory.

Note – When the Reset Drive command is selected, the encryption status indicator 
changes to orange, and the label identifies missing keys. 

Zero Drive 

Caution – DRIVE DAMAGE. Once the drive is zeroed, it is totally disabled and 
must be returned to the factory. DO NOT SELECT ZERO DRIVE WITHOUT 
CONSULTATION WITH SUN STORAGETEK SUPPORT.

This command deletes all encryption keys including the internal enabling key. 

Note – Should you select this command, a confirmation dialog box appears, which will 
allow you to confirm or cancel. 
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▼ Format Tape Submenu 
The offline format tape cartridge dialog box (FIGURE 3-16) provides four utilities.

Three command buttons are on the bottom of the format tape dialog box:
■ Make - Initiates the selected utility.
■ Abort - Terminates an in-progress utility.
■ Done - Closes the dialog box.

Use the following general guidelines to perform any of the utilities: 

1. Make sure the drive is offline.

If not offline, select Drive Operations > Set Offline, or click the Online status indicator 
(see FIGURE 3-15 and “Set Offline/Online” on page 66).

2. Select the appropriate utility radio button. 

Note – See the individual utility paragraphs for additional information and/or detail:
“Make Data Tape” on page 69
“Make Code Tape” on page 70
“Make Dump Tape” on page 70
“Rebuild MIR” on page 70

3. Click MAKE to start the selected utility. 

A prompt to insert a cartridge appears.

Note – If there is a cartridge in the drive, it unloads. 
You must physically remove the unloaded cartridge.

4. Insert a write-enabled cartridge.

The drive performs the selected utility, displays relative information in the VOP 
transcript pane, then unloads the cartridge.

Note – You can cancel a selected utility by clicking ABORT before inserting the 
cartridge. Once the cartridge has been inserted, the utility runs to completion.

FIGURE 3-16 Format Tape Submenu 
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5. Remove the unloaded cartridge.

You now have the following options:

■ Repeat the current selected format tape command (go to Step 3 on page 68).

■ Select a different format tape command (go to Step 2 on page 68).

■ Exit the format tape submenu (continue with Step 6).

6. Click DONE to exit the format tape submenu.

The Format Tape Cartridge dialog box closes.

Make Data Tape 

The Make Data Tape utility reformats a tape cartridge for reuse as a data tape cartridge. 
Existing headers are removed and the MIR is rewritten to identify the cartridge as 
empty and therefore ready for write operations.

Note – The Make Data Tape utility does not erase existing data. Old data can still be 
recovered by special data recovery applications. Therefore, if data security is a concern, 
you must configure the drive for full Data Security Erase (DSE) - Yes, and initiate an 
erase command from the host software before you select the Make Data Tape utility.

Use the general guidelines, beginning on  on page 68, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 3-17) is in the write-enabled (unlocked) position.

FIGURE 3-17 Tape Cartridge Write-Protect Switch 

1. Write-protect switch
2.  Unlocked position
3.  Locked position
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Make Code Tape 
The Make Code Tape utility reformats a tape cartridge with a special format, and 
downloads the drive firmware code from the drive memory to the tape cartridge. The 
MIR is then written to identify the cartridge as a “code” tape. You can use the code tape 
to upload drive firmware to other tape drives Use the general guidelines, beginning  
 on page 68, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 3-17 on page 69) is in the write-enabled (unlocked) position

Note – The VOP heartbeat feature is not compatible with the Make Code Tape utility in 
VOP version 1.0.9, and lower. If the heartbeat feature is active when the Make Code 
Tape utility is initiated, the VOP loses connection to the drive shortly after the drive 
begins the utility. 
 
However, once the utility has started, the drive continues until completion.  
The VOP quickly reconnects to the drive, but does not regain monitoring the utility’s 
progress, nor display a successful code tape completion message. However, the VOP 
detects and displays the cartridge unloading at the end of the utility.  
 
To prevent losing the VOP-to-drive connection during the Make Code Tape utility with 
VOP version 1.0.9 and lower, you must make sure the heartbeat feature is not enabled. 
To disable the heartbeat feature, remove the “-b” parameter from the “sunVOP.bat” file. 
See “Optional Heartbeat Indication, Windows” on page 40 for guidelines to modify the 
batch file. The batch file revision must been done prior to starting the VOP session in 
which you intend to use the Make Code Tape utility.

Make Dump Tape 
The Make Dump Tape utility reformats a tape cartridge with a special formatting. The 
MIR is written to identify the cartridge as a “dump” tape. You can use a formatted 
dump tape to download diagnostic “dump” data from drive memory. Service 
representatives use formatted dump tapes with the diagnostic routines that are 
available offline. 

Use the general guidelines, beginning on page 68, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 3-17 on page 69) is in the write-enabled (unlocked) position.

Rebuild MIR 

You can use the Rebuild MIR utility to repair a data tape cartridge that has an invalid 
or corrupted Media Information Region. The utility reads the file headers all the way to 
the End of Data mark. Then, the MIR is rewritten to correctly reflect the tape contents. 
This utility could take well over one hour to rebuild the MIR on a full or nearly full 
data tape cartridge. 

Use the general guidelines, beginning  on page 68, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 3-17 on page 69) is in the write-enabled (unlocked) position.

Note – See “Media Information Region” in the T10000 Tape Drive Operator’s Guide, 
PN 96174 for additional MIR information.
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Retrieve Menu 
FIGURE 3-18 shows the Retrieve menu commands available online and offline.

See the following sections for more detail and/or guidelines:

■ “View Drive Data” on page 72
■ “View Date & Time” on page 79
■ “Dumps to File” on page 80
■ “Perms to File” on page 81
■ “Logs to File” on page 82

Note – In VOP version 1.0.9 and lower, there is also a Get and Display command in the 
Retrieve menu. However, it is not a functional command with the customer version of 
VOP. Should you select the command, you will only see an error message. 
 
If your operating VOP 1.0.9 or lower, you should upgrade to the newest version.

FIGURE 3-18 Retrieve Menu 
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View Drive Data 
The View Drive Data command (see FIGURE 3-18 on page 71) displays current drive 
configuration settings and other drive data on selectable property sheets (tabs). 
Encryption-capable drives open to the Encrypt tab (FIGURE 3-19). Other drives open to 
the Fibre tab (FIGURE 3-20). 

Note – The View Drive Data property sheets are view (display) only. See “Configure 
Menu” on page 83 for detailed descriptions and guidelines for changing configuration 
settings. 

Encrypt
The Encrypt tab (FIGURE 3-19) displays encryption-related data. 

FIGURE 3-19 View Current Drive Settings, Encrypt Tab
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Fibre

The data displayed on the Fibre tab is specific to the type of drive interface.  
The Fibre Channel Protocol (FCP), shown in FIGURE 3-20, has FCP specific data. The 
Fibre Interface Connection (FICON), shown in FIGURE 3-21 on page 74 has FICON 
specific data. 

 

FIGURE 3-20 View Current Drive Settings, Fibre Tab (FCP Interface) 
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The Fibre tab for the FICON interface (FIGURE 3-21) is very similar to the FCP interface 
(FIGURE 3-20 on page 73), with the exception of the FICON specific emulation setting.

 

FIGURE 3-21 View Current Drive Settings, Fibre Tab (FICON Interface) 
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Manufacturing

The Manufacturing tab (FIGURE 3-22) displays factory preset settings, such as drive serial 
number, and default world wide names.

FIGURE 3-22 View Current Drive Settings, Manufacturing Tab 
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Network

The Network tab (FIGURE 3-23) displays the Network node name. The factory preset 
default is comprised of the drive model number (t10000) and the last nine digits of the 
drive serial number. 

This tab also displays the current static IP settings. FIGURE 3-23 shows factory preset 
static IP parameters, which can be changed through the Configure menu  
(see “Network” on page 100).

FIGURE 3-23 View Current Drive Settings, Network Tab 
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Rfid

The Rfid tab (FIGURE 3-24) displays data stored in the radio-frequency identification 
(Rfid) memory chip in the T10000 tape cartridge. The Rfid chip stores data related to 
cartridge contents and statistics. The data is similar to data stored in the media 
information region (MIR) on the tape, and is updated with each cartridge 
mount/dismount. A Rfid module in the drive reads the Rfid chip while the cartridge is 
loaded, and is viewable (read-only) by the VOP application.

FIGURE 3-24 View Current Drive Settings, Rfid Tab 
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Version

The Version tab (FIGURE 3-25) displays the current drive firmware level.
 

FIGURE 3-25 View Current Drive Settings, Version Tab 
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View Date & Time 
This command displays the date and time of the drive internal clock module. When 
you select View Date & Time (FIGURE 3-26), the drive date and time appears in the VOP 
transcript pane, as shown in FIGURE 3-27. 

Notice in FIGURE 3-27 that the drive clock setting is lagging behind the VOP time at the 
left end of the same text line. The drive clock only operates while the drive is powered; 
therefore, the drive clock time can fall behind real clock time during times that the 
drive is not powered. Most library configurations set the drive clock in-sync with the 
library clock. However, you can manually set the drive clock when the drive is offline.

Note – See “Set Clock” on page 104 to reset the drive clock.

FIGURE 3-26 View Date & Time 

FIGURE 3-27 Date & Time Display 
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▼ Dumps to File
The Dumps to File command (FIGURE 3-28) allows you to retrieve and save diagnostic 
dumps that are currently stored in the drive memory. 

1. Choose Dumps to File to open an operating system save dialog box

The save dialog box allows you to name the file, and where to save the file.

2. Name the file and specify the target folder, then click Save.

The operating system saves the dump file in the specified location.

The VOP transcript (FIGURE 3-29) documents the action, including the path to the file.

Note – Notice that the drive status dump indicator dimmed after the dump file was 
retrieved. However, the dump is still present in drive memory until intentionally 
deleted by service representative, or until the drive firmware is updated.

FIGURE 3-28 Dumps to File

FIGURE 3-29 Dumps to File Transcript
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▼ Perms to File
The Perms to File command (FIGURE 3-30) allows you to retrieve and save all the 
permanent errors that are currently stored in the drive memory. 

1. Choose Perms to File to open an operating system save dialog box.

The save dialog box allows you to name the file, and where to save the file.

2. Name the file and specify the target folder, then click Save.

The operating system saves the perm file in the specified folder.

The VOP transcript (FIGURE 3-31) documents the action, including the path to the file.

FIGURE 3-30 Perms to File

FIGURE 3-31 Perms to File Transcript
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▼ Logs to File
The Logs to File command (FIGURE 3-32) allows you to retrieve and save event logs that 
are currently stored in the drive memory. 

1. Choose Logs to File to open an operating system save dialog box.

The save dialog box allows you to name the file and where to save the file.

2. Name the file and specify the target folder, then click Save.

The operating system saves the log file in the specified folder.

The VOP transcript (FIGURE 3-33) documents the action, including the path to the file.

FIGURE 3-32 Logs to File

FIGURE 3-33 Logs to File Transcript
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Configure Menu
The Configure menu commands (FIGURE 3-35) are available when the drive is offline.

Note – The drive must be offline, and should not be available to the host when 
exercising the Configure menu commands. Some changes require the drive to perform 
an IPL to affect configuration changes. VOP automatically reconnects to the drive after 
the IPL is complete.

1. Make sure the drive is offline.

If not offline, select Drive Operations > Set Offline, or click the Online status indicator  
(see FIGURE 3-34). 

Note – When the drive goes offline, the status indicator turns gray and the label 
changes to Offline; and, the Configure menu label turns blue.

2. Click Configure to display available configuration commands.

FIGURE 3-35 shows the available Configure menu commands.

FIGURE 3-34 Set Drive Offline

FIGURE 3-35 Configure Menu
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▼ Drive Data
The Drive Data command (FIGURE 3-36) allows you to change configuration settings.

1. Choose Drive Data. 

The multi-tab Configure Drive Parameters property sheet opens. 

Note – By default, the property sheet opens to the Fibre tab, relative to the interface of 
the connected drive:  
 
Fibre Channel - FIGURE 3-38, “Configure Drive Parameters, Fibre Tab (FCP))” on page 86. 
 
FICON - FIGURE 3-39, “Configure Drive Parameters, Fibre Tab (FICON)” on page 87.

Before discussing the various configuration setting available to you for change, you 
should be familiar with the three command buttons across the bottom of every tab.  
See “Configure Command Buttons” on page 85 for details.

FIGURE 3-36 Configure > Drive Data
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Configure Command Buttons 

The three command buttons across the bottom of the Configure Drive Parameters 
dialog box (see FIGURE 3-37) directly affect drive configuration settings. 

Load Drive Config
Clicking Load Drive Config allows you to retrieve a previously saved file of 
preselected drive configuration parameters/settings.  
See “Save Drive Config” on page 103 for guidelines on saving drive configuration.

Note – You will need to use normal file browsing to locate the saved file.

Once the retrieved file is opened, it populates all tabs with the saved configuration 
parameter values/settings.

Note – Marked Update checkboxes identify changed parameter values/settings.  
The imported saved configuration file includes drive specific parameters of the 
originating drive. Make sure you clear or reset drive specific parameters to accurately 
reflect the drive importing the saved configuration file.

You have the choice to retrieve a different file, clear check boxes of individual 
marked parameters, edit any specific parameter; or cancel or commit all pending 
(check-marked) configuration changes.

Commit 
Clicking Commit initiates a drive IPL to activate pending changes.

Note – VOP loses connection to the drive when IPL begins. However, VOP 
automatically reconnects to the drive after a successful IPL.

After the drive completes IPL, and VOP has reconnected to the drive, you should 
review Retrieve > Drive Data tabs to verify the new parameter values/settings  
(see “View Drive Data” on page 72). If required, place the drive offline, and repeat 
the configuration process see “Drive Data” on page 84). 

Cancel 
Clicking Cancel clears any/all pending change selections for all four tabs.

FIGURE 3-37 Configure Command Buttons
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FCP Fibre

The FCP Fibre tab (FIGURE 3-38) contains drive FCP configuration settings that you can 
change.

Note – See FIGURE 3-39 on page 87 for the FICON Fibre tab.

Notice that there are three different selection methods on the Fibre tab:

■ Drop-down list boxes - Emulation, language, Pa/b max recv size,  
and Pa/b speed negotiation.

■ Radio buttons - Data compression, Data security erase, Standard Label protect,  
Tape completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

■ Text fields - Library address, and World Wide Name (drive, ports A & B).

When you select a tab, current drive parameter values appear. If you change a setting, 
the adjacent Update checkbox indicates a pending change. Clearing the checkbox 
cancels the pending change for only that parameter.

FIGURE 3-38 Configure Drive Parameters, Fibre Tab (FCP)
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FICON Fibre

The FICON Fibre tab FIGURE 3-39) contains drive FICON configuration settings that you 
can change, 

Note – See FIGURE 3-38 on page 86 for the FCP Fibre tab.

 

Notice that there are three different selection methods on the Fibre tab:

■ Drop-down list boxes - Emulation, Language, Pa/b max recv size,  
and Pa/b speed negotiation.

■ Radio buttons - Data compression, Data security erase, Standard Label protect,  
Tape completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

■ Text fields - Library address, and World Wide Name (drive, ports A & B).

When you select a tab, current drive parameter values appear. If you change a setting, 
the adjacent Update checkbox indicates a pending change. Clearing the checkbox 
cancels the pending change for only that parameter.

FIGURE 3-39 Configure Drive Parameters, Fibre Tab (FICON)
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The following guidelines provide additional detail for changing drive settings.

Note – The current drive parameter settings were selected by the installation team to 
match pre-determined site requirements. Changing the drive parameter setting could 
materially affect drive performance. Therefore, you should change drive parameter 
settings only as instructed by your IT manager, or Sun StorageTek Support.

Emulation

1. Click the down arrow to see an item list of emulation options. 

The available emulation option list appears with the current option highlighted.

2. Select an alternative option in the item list to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

Note – The available emulation options are specific to the active interface. FIGURE 3-40 
shows the FCP options. FIGURE 3-41 show the FICON options.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-40 Emulation Options - FCP

FIGURE 3-41 Emulation Options - FICON
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Data Compression

See FIGURE 3-42 for available data compression options.

1. Click the appropriate radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

Note – Data compression radio buttons are mutually exclusive. The option defaults to 
the last saved selection. Yes is preset at the factory. See TABLE 3-1 for descriptions.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-42 Data Compression Options

TABLE 3-1 Data Compression Option Descriptions

Option Use/Meaning

No Data is not compressed, by default, but can be overridden by the host for a job.

Yes Data is compressed, by default, but can be overridden by the host for a job. 

Off Data compression is disabled by default, and cannot be overridden by the host. 
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Data Security Erase

See FIGURE 3-43 for available data security erase (DSE) options.

1. Click the appropriate radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

Note – The DSE radio buttons are mutually exclusive. The option defaults to the last 
saved selection. No is preset at the factory. See TABLE 3-2 for descriptions.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-43 DSE Options

TABLE 3-2 DSE Option Descriptions

Option Use/Meaning

Yes Enables a full DSE, which writes a random binary pattern on the media, over-writing 
existing data, from the point of an “Erase” command, to the End of Tape mark. 

No Writes an end of data mark on the media that indicates valid data does not exist beyond 
the point of an “Erase” command. Data is actually still present beyond the end of data 
mark, and it can be retrieved by special tape utilities.
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Standard Label Protect

See FIGURE 3-44 for available standard label protect (SL Prot) options.

1. Click the appropriate radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

Note – The SL Prot radio buttons are mutually exclusive. The option defaults to the 
last saved selection. No is preset at the factory. See TABLE 3-3 for descriptions.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-44 Standard Label Protect Options

TABLE 3-3 Standard Label Protect Options

Option Use/Meaning

No Disables standard label protection. 

Yes Enables standard label protection. 

Notes:
Consider the following: 
1. 1. Select Yes if label overwrite code is loaded, or if running standard labels and wish the drive to display a fatal 

error (CHK 33EX) when writing a non-80-byte record for VOLSER or HDR1.
2. 2. Select No if you are using NL or NSL tape processing.
3. 3. POST WRCART cannot be run with Yes selected
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Library Address

FIGURE 3-44 shows the Library address text field.

Note – The library address is a two-character hexidecimal notation, preset at the 
factory to ff. It should remain at ff for all libraries except the 9310 PowderHorn, where 
it is manually keyed to the drive cabinet position, as viewed from the cabinet rear. 

1. Select the current entry.

The setting value is highlighted.

2. Type in the appropriate two-character hexidecimal Library address.

The changed value appears and a check mark appears in the Update checkbox.

Note – Valid entry for L-Series libraries and the SL8500 is the factory default ff. 
Valid entries for the 9310 PowderHorn Library 9741/9741E drive cabinet is  
00 through 09 (top, down), left column; and 0A through 13 (top, down) right column.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-45 Library Address
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Tape Completion Display

See FIGURE 3-46 for available Tape completion display options.

1. Click the appropriate option radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

Note – The radio buttons are mutually exclusive. The option defaults to the last saved 
selection. No is preset at the factory. 

When No is selected, the tape completion display is disabled.

When Yes is selected, the tape completion display appears in the secondary drive 
message window when there is a cartridge loaded in the drive. 

The display (FIGURE 3-47) provides an indication of tape completion (percentage of tape 
media with written data).

Note – The view-only tape completion display is superseded by higher priority messages 
that require use of the secondary window.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-46 Tape Completion Display Options

FIGURE 3-47 Tape Completion Display
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Language 

This option sets the language in which certain operational drive messages, such as 
loading, unloading, etc. (see TABLE 3-4) are displayed in the drive message windows. 

1. Click the down arrow to see an item list of available languages. 

The available language list appears with the current selection highlighted.

2. Select another option in the item list to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

Note – English is preset at the factory.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-48 Drive Message Language Options

TABLE 3-4 Translated Drive Messages 

English Espanol Francias Italiano Deutsch

*Cleaning* *Limpia* Nettoyage *Pulir* Reinigen

*Erasing* *Borrando* Effacement *Cancella* *Loeschng*

Locating Situando Recherche Ricerca Suchen

Loading Cargando Chargement Carico Laden

NT Ready F Noprep P Npret PTG No PRT P N Bereit N

NT Ready U Noprep N Npret NPTG No PRT N N Bereit G

Ready A

Ready F Prepda P Pret PTG Pronto P Bereit G

Ready U Prepda N Pret NPTG Pronto N Bereit N

Rewinding Rebobina Rebobinage Riavvolg Spult-R

Unloading Descarga Dechargemt Scaricam Entladung
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World Wide Name 

The World Wide Name (WWN) identifies the drive node. This string of 16 hexidecimal 
characters (FIGURE 3-49) represents a 64-bit unique identifier that distinguishes the 
individual drive from all other devices, worldwide. Characters 2 through 6 identify the 
specific manufacturer. Sun StorageTek branded devices have the company ID “00104F”. 
Other characters reveal additional information, including an identifier unique only to 
the specific device. 

Sun Microsystems assigns a block of three WWNs (from a pool of company-specific 
WWNs) to each tape drive during the manufacturing process. One for the drive and 
one each for the two fiber-optics interface ports. The drive node is assigned the first 
WWN of the block, and the next two WWNs, in sequence, are assigned to the ports. 
Notice the last two characters in FIGURE 3-49 is “9d”. If you refer back to the entire fibre 
tab (FIGURE 3-38 on page 86, FCP or FIGURE 3-39 on page 87, FICON) the port A 
WWN ends with “9e”, and the port B WWN ends with “9f”.

The ‘(default)’ indicates that this WWN was preset at the factory. Certain libraries 
override the default WWN with a library-assigned dynamic WWN (dWWN). Typically, 
only the last four characters differ from the default WWN. When dWWNs are active, 
‘(library)’ appears in the label. Also, the WWN can be manually overridden with a 
custom WWN. In some circumstances, a service representative might customize a 
replacement drive’s WWN to be the same as the replaced, defective drive’s WWN. This 
precludes a requirement for a full system reset to acknowledge a new WWN.

Note – Indiscriminately changing the WWN could result in the drive being unavailable 
to the host. 

1. Overwrite the appropriate hexidecimal characters with the specified new characters.

The changed value appears, and a check mark appears in the Update checkbox.

Note – When a customized WWN is active, ‘(custom)’ appears in the label.

Note – If a custom WWN is applied to the drive node, custom WWNs must also be applied 
to the interface ports.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change. 
 
The original, factory-preset default WWN can be retrieved from the Retrieve > View 
Drive Data > Manufacturing tab (FIGURE 3-22 on page 75).

FIGURE 3-49 World Wide Name Text Field
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Interface Ports Attributes

There are two identical interface ports attribute groups (FIGURE 3-50):

Note – Pa = Port A, Pb = Port B.

Port Physical Address Attributes

Hard-assigned Physical Address (No/Yes).

When Yes is selected, the drive uses a specified hard physical address (PA).  
When No (factory-preset default) is selected, the drive seeks a soft PA.

Arbitrated Loop Address (loop ID).

This entry (0 - 125) specifies the loop ID when the Hard PA selection is Yes.  
Factory-preset defaults are: 0 for Port A, 1 for Port B.

Soft-assigned Physical Address (Hi/Lo).

Soft PA is effective only when the Hard PA selection is No.  
When Soft PA is Hi, the drive seeks an available loop ID in a descending order. 
When Soft PA is Lo (factory-preset default), the drive seeks an available loop ID in a 
descending order.

Note – Port physical address attributes are only used when the drive is in an 
arbitrated-loop. The settings are not applicable when the drive is in an interface fabric.

1. Reset the port physical address attributes as directed by your IT manager.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-50 Interface Port Attributes
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Maximum Receive Size

The maximum receive (max recv) size determines the maximum data frame size for 
data processing (see FIGURE 3-51).

1. Click on the down arrow to see an item list of available data frame sizes. 

The available frame size list appears with the current selection highlighted.

Caution – POTENTIAL DRIVE DAMAGE. VOP currently displays additional size 
options. The smaller size options are not valid with the T10000 drive. Furthermore, an 
attempt to switch to any setting other than 2112 or 2048, could cause the drive to fail 
complete the IPL DO NOT SELECT ANY SIZE OPTION OTHER THAN 2112 or 2048.

2. Select the alternative option in the item list to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

Note – 2112 is the factory preset default. Do not change unless directed by your IT 
manager or Sun StorageTek Support.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-51 Max Data Frame Size Options
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Port World Wide Name Override

Each port has a unique WWN (see FIGURE 3-52) that can be overridden.

Note – See “World Wide Name” on page 95 for additional information/detail.

1. Overwrite the appropriate hexidecimal characters with the specified new characters.

The changed value is displayed, and a check mark appears in the Update checkbox.

Note – If a custom WWN is applied to the drive node, custom WWNs must also be 
applied to the interface ports.

Note – When a customized WWN is active, ‘(custom)’ appears in the label.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-52 Port World Wide Name Text Fields
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Speed Negotiation

When Auto (see FIGURE 3-53) is selected, the drive operates at the interface negotiated 
speed, which is typically determined by the slowest attached device. When a fixed 
rate is selected, the drive will operate only at the specified speed.

1. Click on the down arrow to see an item list of available port speeds. 

The available port speed list appears with the current selection highlighted

2. Select another option in the item list to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

Note – Auto is preset at the factory. Do not change unless directed by your IT manager 
or Sun StorageTek Support. 
 
A fixed rate might cause the drive to be unavailable, unless all other interface devices 
are set to the same speed.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-53 Port Speed Negotiation Options



 

Using VOP Menus and Controls

100 T10000 Operator’s Guide • September 2007   Revision J • 96179

Network 
The Network tab (FIGURE 3-54) provides network related options. When you select the 
Network tab, the current settings are displayed.

Note – The entries shown in FIGURE 3-54 are preset at the factory, and should only be 
changed by the direction of your IT manager.

FIGURE 3-54 Configure Drive Parameters, Network Tab
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Static IP Address 

Three parameters (FIGURE 3-55) determine the static IP addressing for the drive. 

Each parameter has four 3-digit groups, factory preset to the following values:

Note – If your site is monitored by a Service Delivery Platform (SDP), all monitored 
drives are set to a dynamic IP address, controlled by the dynamic host control protocol 
(DHCP) server, in the SDP unit, which makes the drive static IP address not affective. 
 
Therefore, you cannot even connect the customer VOP to drives monitored by an SDP.

For drives not monitored by an SDP, use the following procedure to edit the static IP 
address fields:

1. Overwrite the IP address digits with the specified new digits.

A check mark appears in the Update checkbox.

2. Repeat Step 1 for the Subnet mask

3. Repeat Step 1 for the Gateway

4. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-55 Static IP Address

Parameter Factory Preset Valid Entries

IP address 010.000.000.001 000 - 255 (each 3-digit group)

Subnet mask 255.255.255.000 000 - 255 (each 3-digit group)

Gateway 000.000.000.000 000 - 255 (each 3-digit group)
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Network Node Name

This text field (FIGURE 3-56) determines the network node name for the drive. 

Note – The factory preset default is: “t10000 - <last nine digits of drive serial number>.

To set a different network node name:

1. Overwrite the appropriate characters with the specified new characters.

A check mark appears in the Update checkbox.

Note – The factory preset network node name should only be changed by specific 
instructions from your IT manager, or Sun StorageTek Support. 
 
If you use a saved configuration file (from a different drive) to change settings, clear the 
update check box. Otherwise, the network node name will change, which could 
negatively impact network operations.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 3-56 Node Name
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▼ Save Drive Config
The Save Drive Config command (FIGURE 3-57) allows you to save the current drive 
configuration settings to a file. The saved file can then be retrieved to restore drive 
configuration settings.

1. Make sure the drive is offline.

If the drive is not offline, set it offline (see Step 1 on page 83).

Note – The Configure label must be blue to allow menu selections.

2. Click Configure, then choose Save Drive Config.

An typical operating system SaveAs dialog box opens.

3. Select a folder location for the file.

Designate a folder location of your choice.

Note – If a suitable folder does not currently exist, you must cancel the operation; then 
create a new folder, using normal operating system tools. 
 
If you create a new folder, go back to Step 2 to resume this utility.

4. Name the new file.

Use a file name that differentiates it from similar files or overwrite an existing file.

5. Save the file.

The new file is now saved and ready for retrieval with the “Load Drive Config” 
command button, on page 85.

FIGURE 3-57 Save Drive Configuration
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▼ Set Clock
The Set Clock command (FIGURE 3-58) allows you to set the drive’s internal clock to the 
current time in your computer. 

Note – The drive clock only operates while the drive is powered on; therefore, the 
drive clock time can fall behind real clock time during times that the drive is not 
powered on.

1. Make sure the drive is offline.

If the drive is not offline, set it offline (see Step 1 on page 83).

Note – The Configure label must be blue to allow menu selections.

2. Click Configure, then choose Set Cock.

The drive internal clock is set to your computer’s clock.

Note – With VOP release 1.0.9 or lower, there is not any indication of the set clock 
action. Therefore, verify the update by selecting Retrieve>View Date & Time.  
 
With VOP release 1.0.10, and higher, a confirmation text line appears in the transcript 
(see FIGURE 3-59).

FIGURE 3-58 Set Clock

FIGURE 3-59 Set Clock Verification
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▼ Code Load from Tape 
The Code Load from Tape command (FIGURE 3-60) allows you to update the drive’s 
firmware to the release level contained on a prerecorded Code Load Tape/Cartridge.

Note – The Code Load Tape/Cartridge can be made from a drive that already has the 
updated drive firmware release level active (see “Make Code Tape” on page 70).

1. Make sure the drive is offline.

If the drive is not offline, set it offline (see Step 1 on page 83).

Note – The Configure label must be blue to allow menu selections.

2. Click Configure, the choose Code Load from Tape.

A text prompt to insert a code load tape appears in the VOP text message pane, and a 
Firmware Update Progress box appears (see FIGURE 3-61).

3. Insert the code load tape/cartridge containing the proper firmware release level.

The Firmware Update Progress box (FIGURE 3-62 on page 106) tracks the update.

FIGURE 3-60 Code Load from Tape

FIGURE 3-61 Code Load from Tape Start
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When the firmware update is completely loaded into the drive memory, the progress 
box disappears, the code load tape/cartridge unloads, and a prompt to remove the 
code load cartridge appears in the VOP text message pane (see FIGURE 3-63).

4. Remove the code load cartridge from the drive load slot.

When the cartridge clears the drive load slot, a drive IPL starts, which will 
load/activate the updated firmware level into the drive RAM.

Note – VOP loses connection to drive during IPL, but automatically reconnects  
once IPL is successfully completed.

5. Select Retrieve>Drive Data>Version tab to verify the updated firmware level.

See FIGURE 3-25 “View Current Drive Settings, Version Tab” on page 78.

FIGURE 3-62 Firmware Update Progress

FIGURE 3-63 Code Load from Tape End
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▼ Help Menu 
The Help menu (FIGURE 3-64) has only one customer-level command: About. 

1. Click Help, then choose About.

The Drive About Dialog box (FIGURE 3-65) displays information about the VOP 
application; and, if connected to a drive, it lists the drive name and IP address.

2. Click OK to close the dialog box. 

You can also click the X in the upper-right corner of the dialog box.

FIGURE 3-64 Help Menu 

FIGURE 3-65 About Dialogue Box 
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APPENDIX

 

A

Changing the Computer IP Address

This appendix provides guidelines to set a static IP address required to connect to the 
drive, and to reset a single Ethernet port for obtaining a dynamic IP address. 

Note – If your computer has two, or more Ethernet ports, you can dedicate one for 
static IP addressing, and leave the one used to connect to the LAN set for dynamic IP. 

Static IP Address
To connect VOP to a T10000 tape drive that has a static IP address, you must make sure 
your computer has a functional Ethernet port with compatible static IP address.

Note – See your system administrator for Linux/UNIX operating systems.

▼ Setting static IP, Windows OS
Use the following procedure to check/set a static IP address for your computer:

1. Click Start, then select Settings > Network Connections. (FIGURE A-1).

FIGURE A-1 Network Connections Selection



 

Static IP Address

110 T10000 Operator’s Guide • September 2007 Revision J • 96179

The Network Connections window (FIGURE A-2) lists all network connections.

2. Double-click the appropriate connection.

The Local Area Connection Properties dialog box (FIGURE A-3) opens.

3. Scroll down to select Internet Protocol (TCP/IP), the click on Properties.

The TCP/IP properties dialogue box (FIGURE A-4 on page 111) opens.

FIGURE A-2 Network Connections Window

FIGURE A-3 Local Area Connection Dialogue Box
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Note – If the port is set for the proper static IP and subnet mask, skip to Step 5. 
Otherwise, perform step 4 to enter/edit the static IP address and subnet mask.

4. Make sure the radio button Use the Use the following IP address is selected, then  
enter a compatible static IP address, Subnet mask, and Default gateway.

See your system administrator, as needed for assistance.

Note – Static IP address 10.0.0.2 is typically used for the computer to be compatible 
with a drive factory preset static IP address 10.0.0.1. However, if the drive’s static IP has 
been customized for your site, you must set the computer’s static IP to be compatible 
with the target drive. The first three digit sets must match, and the last digit set must be 
different from the target drive. The last digit set should also be different than any other 
possible target drive on your site.

5. Click OK.

The Local Area Connection Properties dialogue box (FIGURE A-3 on page 110) 
reappears. 

6. Click OK.

You can now connect to any on-site drive that has a compatible static IP address.

FIGURE A-4 Internet Protocol (TCP/IP) Properties Dialogue Box
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Dynamic IP Address 
If you set a temporary static IP address for an Ethernet port normally used to connect to 
the LAN, you will need to reset the port to automatically obtain a dynamic IP address. 

▼ Resetting IP to Auto, Windows OS
Use the following procedure to reset a local connection for dynamic IP address: 

1. Click Start, then select Settings > Network Connections (FIGURE A-1 on page 109).

The Network Connections window opens (FIGURE A-2 on page 110).

2. Double-click the Local Area Connection associated with the Ethernet port that 
requires change. 

The Local Area Connection Properties dialogue box (FIGURE A-3 on page 110) opens. 

3. Scroll-down, and select Internet Protocol (TCP/IP), then click on Properties. 

You will need to scroll down as TCP/IP is the last selection.

The TCP/IP properties dialogue box (FIGURE A-5) opens.

4. Select Obtain an IP address automatically:

The three IP address fields go blank, and become unavailable for entries.
 

5. Click OK to save the reset.

The Local Area Connection Dialogue box (FIGURE A-3 on page 110) reappears. 

6. Click OK.

The Ethernet port is now set to connect to a LAN. 

FIGURE A-5 Internet Protocol (TCP/IP) Properties (auto IP) Dialogue Box
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B

VOP to Drives on Private Networks

This appendix provides supplemental information about VOP to drives connected on a 
private network. 

Private Network, SDP-Controlled
When a Service Delivery Platform (SDP) is present, all monitored drives are connected 
into a private network, controlled by the SDP site server.

The Ethernet port of every monitored drive is 100% dedicated to the SDP site server, 
and each drive has an SDP-controlled dynamic IP address. Therefore, you do not have 
access to the drive Ethernet port and cannot connect your customer-version VOP to 
such drives.

Note – Only Sun StorageTek service representatives are authorized to access drives 
connected to an SDP-controlled private network. DO NOT disconnect any Ethernet 
cable associated with an SDP-controlled private network.  
 
Contact your Sun StorageTek service representative to change drive configuration 
settings of any drive in the SDP-controlled private network.

However, when an SDP site server is not present, your site personnel can interconnect 
drives from one or more drive cabinets into a non-SDP private network. See “Private 
Network, non-SDP” on page 114.
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Private Network, non-SDP
When an SDP site server is not present, a non-SDP private network (FIGURE B-1), can be 
set up, interconnecting the installed drives to one or more cascaded Ethernet switches. 
Such a network allows you to access any connected drive from a central point.

Overview
In a non-SDP, customer-controlled private network, the Ethernet port of each drive is 
connected to an Ethernet switch. A desktop and/or notebook PC, running the 
customer-version VOP application, would also be connected to the network.

Note – Each connected drive and each computer requires an individual static IP 
address. 

FIGURE B-1 Private Network, non-SDP

1. Desktop PC
2. Notebook PC 

3. Ethernet switch
4. T10000 tape drives



 

Private Network, non-SDP

96179 • Revision J  Appendix B VOP to Drives on Private Networks 115

Components
The following components are required to operate VOP in a non-SDP private network:

■ Computer - One or more desktop or notebook computers

Note – The computer must have the customer-version of VOP application installed, 
and an available Ethernet port configured with a compatible static IP address.

■ Ethernet switches - One, or more Ethernet switches might be required to provide one 
port per drive, one port per computer, plus additional ports to cascade multiple 
switches, as needed.

Note – See the Ethernet switch vender documentation for setup guidelines. 

■ Ethernet Cat 5 cables - One cable per drive, one cable per computer, plus additional 
cables to cascade multiple switches, as needed.

Note – Each Ethernet cable must be long enough to connect to the Ethernet switch port 
with enough slack to allow strain relief.

■ Ethernet cross-over cable - One cross-over cable for direct computer-to-drive 
connection.

▼ Setup
See your site IT manager, system administrator, and support personnel to install and 
setup the Ethernet components, and establish the private network static IP address 
scheme. 

Note – Remember, each drive was preset at the factory with the following:  
Static IP address: 010.000.000.001 
Subnet mask: 255.255.255.000  
Default gateway: 000.000.000.000

Use the following procedure to set up each drive for the private network.

1. Set your computer static IP address to 10.0.0.2 and the subnet mask to 255.255.255.0.

See “Static IP Address” on page 109.

2. Start VOP

See “Starting VOP” on page 56.

3. Connect the Ethernet cross-over cable to the computer Ethernet port and to the drive 
Ethernet port.

4. Connect VOP to the cabled drive.

See “Connect to Drive” on page 64.
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5. Reset the drive static IP address.

See “Static IP Address” on page 101.

Note – Enter the static IP address designated for the cabled drive.  
 
The VOP does not reconnect to the drive following the IPL because the drive static IP is 
no longer 10.0.0.1.

6. Disconnect the Ethernet cross-over cable at the drive end.

7. Connect the Ethernet cross-over cable to the next drive Ethernet port.

The VOP should automatically connect to the drive because it is still attempting to 
reconnect to IP address 10.0.0.1.

8. Repeat Step 5 through Step 7 for each drive.

When all drives are reset, continue with Step 9.

9. Disconnect the cross-over cable from the computer. 

10. Reset the computer static IP address to the private network-designated IP address.

See “Static IP Address” on page 109.

11. Connect the computer Ethernet port to an available port on the Ethernet switch.

Make sure you use a straight Cat 5 Ethernet cable.

12. Make sure every drive is connected to an Ethernet switch port.

Use a straight Cat 5 Ethernet cable for each drive.

Note – Any drive can be connected to any available Ethernet switch port. It is not 
necessary to assign ports to specific drives. However, you should make a listing of the 
assigned IP address for each drive location.

13. Connect VOP to a selected drive.

See “Connect to Drive” on page 64.  
Use the private network-designated drive static IP address.

14. Repeat Step 13 for a few different drives.

Note – You only need to enter the other drive’s designated IP address into the Connect 
to Drive dialog box (FIGURE 3-12 on page 64).

The non-SDP private network is now ready for VOP access to any connected drive.
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Glossary

This glossary defines terms and abbreviations in this publication. 

Some of the definitions are taken from other glossaries. The letters in the parentheses 
that follow some definitions indicate the source of the definition:

(A) The American National Standard Dictionary for Information Systems, ANSI X3.172-1990, 
copyright 1990 by the American National Standards Institute (ANSI).

(E) The ANSI/Electronic Industries Association (EIA) Standard-440-A, Fiber Optic 
Terminology.

(I) The Information Technology Vocabulary, developed by Subcommittee 1, Joint Technical 
Committee 1, of the International Organization for Standardization and International 
Electrotechnical Commission (ISO/IEC/JTC1/SC1).

(IBM) The IBM Dictionary of Computing, copyright 1994 by IBM.

(T) Draft international standards committee drafts, and working papers being 
developed by the ISO/IEC/JTC1/SC1.

A
address A character or group of characters that identifies a register, a particular part of 

storage, or some other data source or destination. (A). 

C
capacity Total amount of User Data stored on one data cartridge in 8 bit bytes. 

Synonymous with “User Capacity” or “Native Capacity”. This is the capacity that 
the user sees after the ECC/Format/ERP etc. overhead has been assessed (no 
compression). 

capacity, raw Total amount of data stored on one data cartridge in 8 bit bytes before any 
ECC/Format/ERP etc. overhead has been assessed (no compression). 

capacity, user Total amount of data stored on one data cartridge in 8 bit bytes that is sent by 
the host computer. This is the capacity that the user sees after the 
ECC/Format/ERP etc. overhead has been assessed (no compression). 
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cartridge A storage device that consists of magnetic tape on supply and takeup reels, in a 
protective housing. (IBM)

cleaning cartridge A data cartridge that contains special material to clean the tape path in a 
transport or drive. 

compress To save space by eliminating gaps, empty fields, redundancy, or unnecessary 
data to shorten the length of records or files. (IBM)

configuration The manner in which the hardware and software of an information processing 
system is organized and interconnected. (T)

connector An electrical or optical part that joins two or more other parts.

D
data cartridge A container holding magnetic tape that can be processed without separating the 

tape from the container. 

data security erase (DSE) A random binary pattern, over-writing existing data, from the point of an Erase 
command, to the end-of-tape.

data tape A data cartridge formatted for use as a regular data tape for the system in which 
it is used. 

data track(s) The region(s) of recorded tape containing user data formed as discreet 
longitudinal “tracks” (similar to railroad tracks). 

diagnostics Pertaining to the detection and isolation of errors in programs and faults in 
equipment. (IBM)

drive A device for moving magnetic tape and controlling its movement. (IBM)

dump To copy the contents of all or part of virtual storage to collect error information. 
(IBM)

E
emulation The use of programming techniques and special machine features to permit a 

computing system to execute programs written for another system. (IBM)

EOT End of Tape. 

error A discrepancy between a computed, observed, or measured value or condition 
and the true, specified, or theoretically correct value or condition. (I) (A)

ESD Electrostatic Discharge. 
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F
fault symptom code 

(FSC) A four-character hexadecimal code generated in response to an error to help 
isolate failures within the device. 

FC See fibre channel.

fiber optics The branch of optical technology concerned with the transmission of radiant 
power through fibers made of transparent materials such as glass, fused silica, 
and plastic. (E)

fiber-optic cable A cable made of ultrathin glass or silica fibers which can transmit data using 
pulses of laser light. Fiber-optic cables have several advantages over copper 
cables: they have much less signal loss; they allow information to be transmitted 
at higher speeds and over longer distances; they are not affected by external 
electrical noise; and they are better for transmissions which require security.

fibre channel The National Committee for Information Technology Standards standard that 
defines an ultrahigh-speed, content-independent, multilevel data transmission 
interface that supports multiple protocols simultaneously. Fibre Channel 
supports connectivity to millions of devices over copper and/or fiber-optic 
physical media and provides the best characteristics of both networks and 
channels over diverse topologies.

fibre connection 
(FICON) An ESA/390 and zSeries computer peripheral interface. The I/O interface uses 

ESA/390 and zSeries FICON protocols (FC-FS and FC-SB-2) over a Fibre 
Channel serial interface that configures units attached to a FICON-supported 
Fibre Channel communications fabric.

FICON See fibre connection (FICON). 

FICON channel A channel having a Fibre Channel connection (FICON) channel-to-control-unit 
I/O interface that uses optical cables as a transmission medium. 

file-protect To prevent the erasure or overwriting of data stored on data cartridges.

FIPS Federal Information Processing Standards

FRU Field Replaceable Unit. 

FSC Fault Symptom Code. 

FTP Generic definition: File Transfer Protocol. 

G
GB See gigabyte (GB).

Gb Gigabit, equal to 109 bits.

Gbps Gigabits per second.

gigabyte (GB) One billion (109) bytes. 
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H
hardware All or part of the physical components of an information processing system, 

such as computers or peripheral devices. (T) (A)

hub A Fibre Channel Arbitrated Loop switching device that allows multiple servers 
and targets, such as storage systems, to connect at a central point. A single hub 
configuration appears as a single loop.

I
indicator A device that provides a visual or other indication of the existence of a defined 

state. (T)

interface Hardware, software, or both, that links systems, programs, or devices. (IBM)

internet protocol (IP) A protocol used to route data from its source to its destination in an Internet 
environment. (IBM)

internet protocol (IP) 
address A four-byte value that identifies a device and makes it accessible through a 

network. The format of an IP address is a 32-bit numeric address written as four 
numbers separated by periods. Each number can be from 0 to 255. For example, 
129.80.145.23 could be an IP address.

IP See internet protocol (IP)

L
library A robotic system that stores, moves, mounts, and dismounts data cartridges that 

are used in data read or write operations.

link A physical connection (electrical or optical) between two nodes of a network.

M
menu A list of options displayed to the user by a data processing system, from which 

the user can select an action to be initiated. (T)
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N
network An arrangement of nodes and branches that connects data processing devices to 

one another through software and hardware links to facilitate information 
interchange.

O
offline Neither controlled by, nor communicating with, a computer. (IBM)

online Pertaining to the operation of a functional unit when under the direct control of 
the computer. (T)

P
performance One of two major factors, together with facility, on which the total productivity 

of a system depends. Performance is largely determined by a combination of 
throughput, response time, and availability. (IBM)

R
read/write head The data sensing and recording unit of a diskette magazine drive or tape drive. 

(IBM)

release A distribution of a new product or new function and fixes for an existing 
product. (IBM)

R/W Read/Write.

S
SDP Service Delivery Platform. 

submenu A menu related to and reached from a main menu. (IBM)

sub-system A system that is part of some larger system. 

switch In Fibre Channel technology, a device that connects Fibre Channel devices 
together in a fabric.

system A combination of functionally interrelated interacting mechanical and electrical 
elements designed to work as a coherent entity. 
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T
tape drive A device for moving magnetic tape and controlling its movement. (T)

TCP/IP Transmission Control Protocol/Internet Protocol

transmission control 
protocol/internet protocol 

(TCP/IP) A set of communication protocols that support peer-to-peer connectivity 
functions for both local and wide area networks. (IBM)

V
T10000 Tape Drive

(VOP) A software application that allows a user to monitor and perform some 
operations on a large number of tape drives remotely.

VOLSER VOLume SERial Number. It is, usually 6 characters long and is both the paper 
label stuck on the back edge of the cartridge and in the VOLID label that is 
recorded, particularly by MVS systems, at the beginning of the media. 

volume serial number 
(VOLSER) An alphanumeric label that the host software uses to identify a volume. It 

attaches to the spine of a cartridge and is both human- and machine-readable.

VOP See T10000 Tape Drive (VOP).

W
wrap A single pass of tape from either BOT to EOT or EOT to BOT with the head(s) in 

a fixed transverse location. 

write-enabled A setting on a data cartridge that allows data to be written on the tape.

write-protected A setting on data cartridges that prevents data from being written on the tape. 
Reading data is still possible.
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